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Design Technology Model

Somos um escritório brasileiro, com sedes no Brasil e no Chile, que desenvolve projetos de arquitetura desde a fase de concepção. Atuamos nos segmentos 
residencial, corporativo, industrial e institucional. Executamos atividades em diferentes etapas, desde a análise da viabilidade do projeto e de seu programa de 
necessidades, até as fases de detalhamento e acompanhamento da obra. Nossos profissionais utilizam tecnologias avançadas para coordenar e gerenciar todas as 
etapas do projeto.
A DTM Studio é atenta ao desenvolvimento tecnológico para entregar projetos de alta qualidade. Neste contexto, destaca-se a Tecnologia/Metodologia BIM (Building
Information Modeling – Modelo de Informação da Construção) que é utilizada pelo escritório para o desenvolvimento de seus projetos.

http://www.dtmstudio.com.br/
https://www.facebook.com/dtmstudioarquitetura/
https://www.facebook.com/dtmstudioarquitetura/
https://plus.google.com/u/0/b/103555620369160842485/103555620369160842485
https://plus.google.com/u/0/b/103555620369160842485/103555620369160842485
https://www.instagram.com/dtmstudio/
https://www.instagram.com/dtmstudio/
https://twitter.com/DTMStudio
https://twitter.com/DTMStudio
https://www.youtube.com/channel/UCD0M6WhUA9xXINEOXjLQOnQ
https://www.youtube.com/channel/UCD0M6WhUA9xXINEOXjLQOnQ
http://www.dtmstudio.com.br/
http://www.dtmstudio.com.br/
https://www.linkedin.com/company/dtm-studio-arquitetura
https://www.linkedin.com/company/dtm-studio-arquitetura
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Criamos seu empreendimento e 
estudamos suas Viabilidade com 
muita Criatividade e Tecnologia.

Colaboramos em conjunto com 
outros escritórios no 
desenvolvimento de projetos.

Trabalhamos em conjunto com 
outros escritórios passando o 
projeto de 2D para 3D.

Gerenciamos seu Projeto BIM 
buscando atingir seus objetivos, 
otimizando o uso de recursos.

Elaboramos bibliotecas específicas 
de acordo com as necessidades do 
seu projeto e do seu escritório.

Elaboramos aplicativos para 
iPhone e iPad.

Executamos treinamentos 
focados utilizando a nossa 
experiência profissional.

Executamos a compatibilização do 
projeto utilizando ferramentas de 
checagem de interferências em 3D.

Coordenamos seu Projeto BIM, 
fornecendo diretrizes para a 
execução correta dos modelos.

Elaboramos plug-ins para o 
software Autodesk Revit.

Extraímos os quantitativos através 
do modelo BIM, no qual todas as 
informações estão integradas.

Simulamos o seu projeto em 4D 
através do planejamento de 
execução da obra.
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Projetos Recentes

Edifício Comercial  
Projeto aflalo/gasperini
Colaboração no Desenvolvimento
Localização  |  São Paulo - Brasil 
Área | 20.576 m² Data | 2015

Edifício Comercial 
Cliente | Odebrecht
Colaboração no Desenvolvimento
Localização | Rio de Janeiro - Brasil
Área | 114.470 m²        Data | 2014

Edifício Comercial  
Projeto aflalo/gasperini
Colaboração no Desenvolvimento
Localização |  São Paulo - Brasil 
Área | 8.900 m²      Data | 2015

Edifício Residencial 
Cliente | ROSSI 
Colaboração no Desenvolvimento
Localização |  Porto Alegre - Brasil 
Área | 12.490 m²         Data | 2015
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Entre no mundo BIM! Mude sua cabeça...
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01. Onde Baixar?
02. Não Encontro as Bibliotecas! 

03. Como Começar Seu 1º Projeto
04. Unidades Projetos
05. Unidades Cotas
06. Restaurar a Interface?
07. Shortcuts
08. Edições Rápidas

09. Minha Simbologia Sumiu!
10. Meus Níveis Não Aparecem!
11. Visualização dos Níveis
12. Oriente View

13. Como Criar Níveis
14. Crie Osso e Acabado
15. Cadê a Biblioteca de Parede?
16. Construção Paredes
17. Edição Paredes
18. Controlar a União
19. Problemas de Importação CAD

20. Vistas para Folha e Trabalho!
21. Organizar Vistas!

22. Onde Baixar Famílias?

Razão deste E-book?

Acumulamos mais de 15 anos de experiência 
em desenvolvimento de projetos. Durante 
esta trajetória, percebemos a grande 
dificuldade dos nossos parceiros em serem 
excelentes nas ferramentas de projeto. 

Com o BIM, vemos que estamos caminhando 
para o mesmo problema.

Tínhamos duas alternativas: ficar 
reclamando eternamente do mercado que 
não evolui ou ajudar os nossos amigos e 
demais profissionais a se qualificarem. 

Nossa meta é propagar não só o nosso 
conhecimento, mas também nossa vontade 
de se aprimorar constantemente!

Diretor
Jonatas Olim

Diretora
Deborah Costa
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Existem 3 formas de você utilizar a versão 
original e gratuita do Revit, baixando 
diretamente do site da Autodesk.

1. Free Trial:
Você pode baixar a versão gratuita de 
avaliação por 30 dias (veja ao lado).

2. Licença Educacional:
Estudantes e professores podem obter 
licença gratuita por 3 anos.
Clique no link para baixar.
http://bit.ly/Download_Revit_Educacional

3. Licença Home:
Se você já tem uma licença original do 
software na sua empresa, você tem direito à 
versão Home da mesma licença, podendo 
utilizá-la em sua casa. 

Siga os passos ao lado e veja como prosseguir.

Revit versão Free Trial 30 dias.
http://bit.ly/Download_do_Revit

Escolha o idioma que desejar.

Recomendamos que você utilize a versão em 
inglês. É a primeira a ser lançada e a maioria 
dos tutoriais e referências encontram-se nessa 
língua.

Após baixar o software, click em Instalar.

Abra as opções e selecione os pacotes 
de conteúdo que deseja baixar.

Boa parte do conteúdo é o mesmo. 
Mudam apenas o idioma e a quantidade 
de famílias específicas por pais.

Selecione pelo menos:

http://bit.ly/Download_Revit_Educacional
http://bit.ly/Download_do_Revit
http://bit.ly/Download_do_Revit
http://bit.ly/Download_do_Revit
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Um problema recorrente é a perda das 
bibliotecas ou o fato das bibliotecas não 
serem baixadas durante a instalação. 

Isso acontece por 2 motivos:
1. Configuração na instalação:
Como vimos na Dica 01, você deve 
selecionar as bibliotecas a serem baixadas. 
Caso esqueça de selecioná-las, elas não 
serão baixadas.

2. Problema na internet durante instalação:
Este problema acontece praticamente em 
90% dos casos. As bibliotecas são baixadas 
durante o processo de instalação. Caso 
aconteça algum problema de conexão com a 
internet durante a instalação, o processo de 
download das bibliotecas será interrompido.

Siga os passos ao lado para corrigir o problema.

No painel de controle do Windows, siga o 
caminho abaixo:
Painel de Controle\ Programas\Programas e Recursos

Selecione Autodesk Revit Content Libraries e clique em 
Desinstalar/Alterar.

Nesta tela você poderá desinstalar, reparar, 
reinstalar e adicionar ou remover 
características. 
Caso precise adicionar novas bibliotecas, 
clique em Add or Remove Features.

Clique em repair or reinstall e em seguida 
clique em Reinstalar. O processo de 
atualização iniciará. 

Vazia

Painel de Controle/Programas/Programas e Recursos
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É muito simples iniciar seu projeto em Revit. 
Mas o mais importante aqui é entender que 
há dois tipos de arquivos.

1. Template de Projeto (.RTE):
Quando iniciamos um projeto, abrimos um 
arquivo template. 
Este arquivo é o seu template padrão para 
início de todos os seus projetos. 
Ele pode estar em sua biblioteca e também 
pode ser acessado por várias pessoas.

2. Arquivo do Projeto (.RVT):
Quando salvar pela primeira vez seu projeto, 
ele irá ter a extensão .RVT. Este é o formato 
do arquivo de projeto.

Siga os passos e veja como é simples.

Em Projects, clique em New e em seguida 
selecione o template desejado.

Pronto! Aqui está seu primeiro arquivo de 
projeto.

Na seção Families, estão as opções para abrir ou 
criar uma família. Na seção Projects, estão as 
opções para abrir ou criar novos projetos.

Assim que você salvar o arquivo, ele se tornará 
um arquivo .RVT.
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Uma dúvida que é muito simples de ser 
resolvida e que sempre surge ao iniciarmos 
no REVIT é: 

Como mudar as unidades do projeto? 

Primeiramente, temos que entender como 
funcionam as unidades de Projeto. 
As unidades de projeto controlam todos os 
elementos do projeto.

Diferentemente de alguns outros softwares, 
o Revit não escalona os projetos quando as 
unidades são mudadas. Ele simplesmente 
muda a forma de visualização das unidades.

Siga os passos ao lado para mudar as unidades 
de projeto e também para criar uma cota 
desconectada das unidades de projeto.

Veja que ao mudar as unidades do projeto 
todos os elementos e parâmetros 
relacionados a esta unidade foram alterados 
(cota, tabela, parâmetros de elementos, etc.)

Selecione a cota existente, clique em edit
type> duplicate (crie o nome). Depois, clique 
em Units Format e desabilite a opção Use 
Project Settings. Selecione a nova unidade.

Para mudar as unidades do projeto digite “UN” 
ou vá em Manage > Project Units.

Clique em cada item para mudar sua unidade 
correspondente.

Por exemplo, em Length (comprimento) mude a 
unidade de milímetros para metros.
Repare também que você pode mudar a forma 
através da qual os dígitos são agrupados em 
Decimal symbol/digit grouping.
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Quando estamos construindo nosso projeto, 
se não estivermos atentos, podemos acabar 
tendo casas decimais quebradas.

Muitas vezes isso acontece quando 
utilizamos arquivos externos como 
referência ou quando utilizamos cotas com 
poucas casas decimais.

Esse problema gera uma grande dor de 
cabeça durante o desenvolvimento do 
projeto e deve ser evitado desde a etapa 
inicial.

A dica é criar uma cota especifica para a 
verificação com várias casas decimais. Isso 
auxiliará na construção do seu projeto.

Siga os passos ao lado para criar a cota.

Utilize a cota de verificação para auxiliar na 
construção e evitar erros.

Selecione a cota existente, clique em edit type> 
duplicate (coloque o nome Cota Verificação).

> Clique Units Format
> Desabilite o Use Project Settings
> Selecione a nova unidade.
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Quando iniciamos em um novo software as 
coisas mais simples podem se tornar 
complicadas. Como por exemplo, “Fechei 
sem querer o Project Browser. E agora?”

Como restaurar a interface? 

O processo é bastante simples. Vá na aba 
View/User Interface. Lá você irá encontrar as 
opções para habilitar e desabilitar todos os 
itens.

Você pode também adicionar Shortcuts
(atalhos de teclado). Veja na próxima Dica! ;)

Siga os passos ao lado para restaurar a
interface.

Para restaurar a interface clique em View > User Interface e selecione os itens a serem habilitados.
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Sem dúvida, os atalhos de teclado trazem 
uma maior agilidade durante o processo de 
trabalho. 

Veja como você pode customizar os atalhos 
de acordo com as suas preferências.

Além disso, você pode exportar e importar 
atalhos, mantendo um padrão na sua 
equipe, ou levar seus atalhos para outro 
computador usando-os em uma nova versão 
do Revit.

Siga os passos ao lado para customizar os seus 
shortcuts.

Para importar shortcuts, clique em import e 
em seguida selecione o arquivo XML desejado.

Para exportar shortcuts, clique em Export e 
em seguida dê um nome ao seu arquivo 
XML.

Para abrir o gerenciador de Shortcuts, clique em 
View > User > Keyboard Shortcuts

Selecione o comando desejado e no campo 
Press new Keys coloque a abreviação desejada e 
em seguida clique em +Assign .
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Para editar um elemento rapidamente 
podemos utilizar o Double-click. 
Apenas clicando duas vezes sobre o 
elemento desejado você habilita a sua 
edição.

Isso pode te trazer um grande beneficio, mas 
em alguns casos um problema. Veja como 
você pode customizar o Double-click de 
acordo as suas preferências.

Siga os passos ao lado para customizar o 
Double-Click.

Aqui você pode alterar os tipos de ações do 
duplo clique em cada um dos elementos 
abaixo.

No menu superior clique no ícone Revit e em 
seguida em Opções. O programa Irá abrir uma 
nova janela. Vá até User Interface, em Double-
click Options e clique em Customize.

Exemplo:
Em Família, você pode mudar o double-click 
para editar o Tipo, editar a Família ou não 
fazer nada.



Quando estamos em um processo de mudança tudo tende a nos fazer desistir. 
Seja perseverante. Entenda que há dificuldades. O importante é estar 

preparado para enfrentá-las. 

Não faça para ver se vai dar certo, FAÇA ATÉ DAR CERTO!

Jonatas Olim.
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Algo que ocorre muito e com certeza poderá 
ocorrer com você é:
Onde estão as simbologia de cortes? E as de 
elevação?

Existem várias possibilidades que podem 
influenciar a não visualização das 
simbologias. Vamos abordar aqui as 
principais que ocorrem em 99% dos casos.

Vamos tomar como exemplo um corte, mas 
a sequência é a mesma para outros tipos de 
vistas.

1. Corte não chega até o nível representado.
2. Controle de visibilidade da vista.
3. Elemento escondido (Hide).
4. Pode ter sido deletado!  

Siga os passos ao lado e veja como prosseguir.

B. Criar uma simbologia de corte referenciado.
Clique em View>Section, habilite Reference
Other View e selecione o corte desejado.
Obs. Use este procedimento com parcimônia.

Veja na imagem abaixo que a simbologia 
aparece no térreo mas não no 1º pav.

Como podemos ver na vista de corte, o mesmo 
não chega no nível do 1º pavimento. Por isso o 
Revit entende que este corte não existe neste 
nível para ser representado.

Você poderá corrigir isto de duas formas:
A. Aumentar o corte para alcançar o 1º Pav.

Habilite Reveal Hidden Elements, selecione 
a simbologia e clique em Unhide Element.

Reveal Hidden Elements

Em Visibility Graphic (VV), vá em Annotation
Categories e Habilite “Sections”. Veja 
também se existe algum filtro habilitado.
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Um problema bastante comum que ocorre 
com quem está iniciando em Revit é:

Meus níveis não aparecem nos meus cortes!

Assim como na dica anterior, a relação 
paramétrica entre os elementos prevalecem. 
Aquilo que não está sendo visto ou 
interceptado pelo corte não será 
representado.

Existem mais variáveis que podem esconder 
um nível em corte, mas vamos abortar as 4 
principais.

1. O corte não está interceptando o nível.
2. Controle de visibilidade da vista.
3. Elemento escondido.
4. Pode ter sido deletado!

Siga os passos ao lado e veja como prosseguir.

Perceba na 
elevação que a 
linha de corte não 
esta interceptando 
os níveis.

Habilite Reveal Hidden Elements. Selecione 
a simbologia e clique em Unhide Element.

Reveal Hidden Elements

Em Visibility Graphic (vv), vá em Annotation
Categories e Habilite “Levels”. Veja também 
se existe algum filtro habilitado (Filters).

Selecione o nível 
habilitado em sua 
ponta como 3D e 
arraste até 
interceptar o corte.

Veja que agora os 
níveis aparecem 
em corte. 
Para customizar o 
comprimento dos 
planos de níveis 
sem perdê-los em 
outras vistas, veja a 
Dica 11. 
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Como vimos na dica anterior, os níveis em 
3D podem estar em posições indesejadas 
aparecendo nas vistas do projeto.

Um problema bastante comum acontece 
quando você cria um corte novo e a vista fica 
inteiramente “poluída” de níveis. 

Para você conseguir organizar esses níveis, 
como por exemplo numa régua lateral 
encurtando sua extensão, você deve 
transformar a visualização desse nível para 
2D. Isso fará com que este nível seja do 
projeto, mas será customizado apenas para 
uma apresentação diferente nesta vista.

1. Alteração individual.
2. Alteração em grupo.

Siga os passos ao lado e veja como prosseguir.

1. Verifique se o Crop View e Hide Crop
estão habilitados.

Selecione o nível a 
ser modificado. 
Clique em 3D para 
ser alterado para 
2D. Assim, esta 
alteração só vai 
acontecer nesta 
vista.

Segure e arraste a 
ponta do nível até 
a posição desejada.

Pronto! O Nível do 
1º Pavimento foi 
alterado em 
relação aos outros.

Se quiser alterar os 
outros poderá 
fazer o mesmo 
para cada nível, um 
a um. Mas temos 
mais uma dica para 
você!

2. Selecione, segure e arraste a lateral do 
Crop View próximo à posição desejada.
Em seguida selecione o Nível. Perceberá que 
todos estão em 2D e conectados. Faça agora 
um pequeno ajuste para posição desejada.

3. Volte o Crop View para a posição inicial. 
Pronto! Todos os níveis foram alterados ao 
mesmo tempo.
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Quando estamos trabalhando em corte, 
planta ou em qualquer outra vista 2D, é uma 
boa prática utilizar uma vista 3D ao lado para 
auxiliá-lo na construção. 

Com isso, podemos gerar uma vista 3D 
exatamente de onde estamos trabalhando. 
Isso quer dizer que podemos gerar um 3D a 
qualquer momento através de uma vista 2D.

Com o ViewCube, é possível orientar uma 
vista 3D para qualquer vista de planta, 
elevação, corte ou outro 3D do projeto.

Siga os passos ao lado e veja como é fácil gerar 
suas vistas 3D orientadas.

1. Selecione Oriente to View e, em seguida, 
selecione o tipo Sections e o nome do corte. 

Abaixo temos uma vista em planta e outra em 
3D. Iremos orientar a vista 3D para a vista em 
planta, tendo assim uma vista 3D exata desta 
planta. 

1. Na vista 3D, clique com o botão direito do 
mouse no ViewCube ou clique na seta ao lado.

Selecione Orient to View e, em seguida, 
selecione o tipo Floor Plans e o nome da planta. 

Topo e Base do box 3D.
A vista 3D orientada para planta segue as 
configurações do View Range. Top para o topo 
da Section box e Botton para sua base. 

Topo e Base do box 3D.
A vista 3D orientada 
para corte segue as 
configurações de inicio e 
profundidade do corte.
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Os níveis são a base para a construção do 
seu projeto. 

Aqui iremos ver dois métodos de como criar 
os níveis.

1. Criar o nível com Copy.
2. Criar o nível com o comando Level.

Siga os passos ao lado para criar os níveis.

1. Selecione o nível a ser copiado.
2. Utilize o comando Copy.
3. Perceba que o nível foi criado, mas não foi 
gerada a sua representação no Project Browser.

1. Vá na aba Archtecture e clique em Level

Como gerar a representação do nível no Project 
Browser:
4. Clique em Plan Views> Floor Plan.
5. Selecione o nível e clique em Ok
6. Nível gerado no Project Browser

2. Em uma vista de Elevação, crie o Nível
3. Perceba que deste modo o nível é gerado 
automaticamente no Project Browser
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Uma metodologia que utilizamos para os 
projetos, independentemente do seu porte, 
é criar nível osso e nível acabado.

No Revit, os elementos se relacionam 
parametricamente com o nível. Isso significa 
que é possível controlar os elementos 
através dos níveis em que eles se encontram.

Construímos os elementos referenciando o 
nível. Exemplos: no nível osso, elementos 
estruturais, alvenarias, etc. No acabado, piso 
acabado, peças sanitárias, esquadrias, etc.

Siga os passos ao lado e veja como prosseguir.

Corte com a régua de níveis piso acabado e 
osso

Crie o nível acabado e o nível osso 
correspondente ao pavimento. Esse nome pode 
ser o que desejar: nível concreto, etc.

Crie os elementos nos níveis a eles pertinentes: 
Nível Osso: Pilares, Vigas, Lajes, Alvenarias, etc.
Nível Acabado: Piso Acabado, Peças Sanitárias, 
Esquadrias, Divisórias, etc.
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Algo que praticamente acontece com todos 
que estão começando no Revit é:
“Fui em Load Family, mas não encontrei de 
jeito nenhum as famílias de parede!”

Antes de ver como carregar este tipo de 
família, temos que entender como 
funcionam as famílias no Revit.

Resumidamente, podemos dizer que o Revit 
possui 3 tipos de famílias e cada uma deve 
ser tratada de forma diferente.

Tipos de famílias:
- Sistema.
- Carregáveis.
- In Loco

Siga os passos ao lado e veja como prosseguir.

No Revit, temos 3 tipos de famílias. As famílias 
carregáveis, de sistema e in loco.

As famílias carregáveis são criadas em arquivos 
RFA externos e carregadas em seus projetos.
Exemplo:

- Portas
- Peças Sanitárias
- Pilares

- Folhas
- Legendas
- Detalhe 2d

As famílias do sistema são pré-definidas no 
Revit e salvas no modelo (projeto). Não são 
carregadas a partir de arquivos externos. 
Para criar suas próprias famílias, você deve 
duplicar (copiar) e modificar os tipos de 
famílias existentes.
Exemplo de famílias do sistema:

São elementos personalizados que você cria 
no contexto do seu projeto, geometrias 
únicas, que você não pretende 
reutilizar. Para transferi-las, use os 
comandos Ctrl+C e Ctrl+V (colar) no 
projeto de destino.

Transferir ou importar famílias de sistema.
Mesmo essas famílias não sendo carregáveis, 
podemos transferi-las de um projeto para outro 
com os comandos Ctrl+C (copiar) e Ctrl+V 
(colar). Ou utilizar o Transfer Project Standards, 
transferindo 
todas as famílias entre os projetos. 
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2. Comando Join.
Vá na barra de ferramentas em 
Modify, clique em Join e em 
seguida clique na laje; depois 
na Alvenaria. Com isso, você une os dois 
elementos. 

Quando construímos as alvenarias devemos 
ficar atentos tanto na sua construção em 
planta quanto ao que está acontecendo em 
Corte e 3D. 

Muitas pessoas não usam as várias 
possibilidades de vistas para a construção, se 
apegando somente na visualização em 
planta ou corte. Isso é resquício da prática de 
uso do CAD.

O que acaba acontecendo são paredes sendo 
criadas em níveis errados, invadindo lajes, 
vigas, outros pavimentos, etc.

Apresentamos um método para você iniciar 
seu projeto controlando esses erros. 

As dicas precisam ser adequadas a cada 
situação, tipo e tamanho de projeto.

Siga os passos ao lado e veja como prosseguir.

Construa sua alvenaria referenciando os níveis:
Base Constraint: Osso do pavimento
Top Constraint: Osso do pavimento superior

Com isso, temos a alvenaria sendo construída 
em sua base e topo com as devidas referências. 
Quando houver alguma mudança de nível a 
alvenaria será corrigida automaticamente.

1. Comando Attach Top.
Selecione a alvenaria e em 
seguida selecione o comando 
Attach Top/Base. Depois clique 
na Laje. Com isso, você conectou a alvenaria à
base da laje eliminando a interferência.

Existem várias formas de 
corrigir o problema de 
interferência com a laje, viga, etc. 
Iremos apresentar as 
3 principais que você pode 
utilizar dependendo de cada 
situação em seu projeto.

2. Top Offset.
Selecione Alvenaria. 
Em Properties, clique em Top Offset e digite o 
valor da espessura a ser descontada. Ela estará 
sempre com o valor do nível superior mesmo 
que mude no futuro.
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Durante as Etapas de Projeto em BIM, temos 
várias fases de nível de detalhe do modelo:
(LOD) 100, 200, 300 e 400. Cada uma 
comportando os elementos com seu nível de 
detalhe específico. 

No caso das alvenarias, podemos dizer que 
elas começam com um nível mais simples, 
como por exemplo uma espessura única e 
em etapas futuras acabam recebendo suas 
camadas de revestimentos ou até mesmo 
sendo alteradas por conta de acústica, 
incêndio, processo construtivo, etc.
Então, teremos que substituir ou alterar 
essas alvenarias.

Entender como a alvenaria pode ser alterada 
é primordial para não termos acréscimos ou 
perdas de áreas no projeto e também agilizar 
o trabalho!

Siga os passos ao lado e veja como prosseguir.

Quando construímos uma alvenaria, ela é 
construída referenciada pela face acabada 
exterior/interior, face osso exterior/interior, 
centro da alvenaria ou centro do osso.

Para saber como sua alvenaria foi construída, 
basta selecioná-la e em properties verificar em 
Location Line por onde ela está sendo 
referenciada.

Para alterar as alvenaria de um ambiente sem 
modificar sua área interna, selecione todas as 
alvenarias desse ambiente e modifique para 
Finish Face Interior.
Em seguida, selecione a nova alvenaria em 
properties. Ele irá substituir as alvenarias 
seguindo a referência da face interior, 
mantendo assim sua área interna.

Perceba que 
as cotas 
internas 
1.00 e 1.50 
foram 
mantidas.
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Para alinha-la, vá em Modify e clique em Align
(AL). Clique na face acabada da 
parede de bloco e depois na face 
a ser alinhada da parede 
de Drywall.

Quando estamos construindo em Revit, 
existem funções automáticas do software às 
quais devemos ficar atentos para não 
virarmos reféns do nosso projeto em relação 
à construção e representação dos nossos 
elementos.

Como por exemplo o Join, união automática  
dos elementos.

Quando utilizamos a família de sistema 
parede, podemos criar vários tipos de 
alvenarias e fechamentos. Como por 
exemplo, bloco de concreto com 
acabamentos e outro tipo como drywall. 

Nesse caso, os elementos, por serem 
sistemas diferentes e de materiais 
diferentes, não devem ser unidos e sim 
alinhados. Veja como a nossa dica irá corrigir 
este problema.

Siga os passos ao lado e veja como prosseguir.

Com o join automático do Revit, a parede tipo 
Drywall está atravessando o acabamento da 
parede de bloco de concreto e unindo com o 
osso. Neste caso, queremos parar o Drywall
alinhado com o acabamento da parede de 
Bloco. Como fazer isso?

Para desabilitar o join automático, selecione a 
parede de Drywall. Irá aparecer um pequeno 
ponto em sua extremidade, clique com o botão 
direito do mouse e vá em Disalow Join.

Veja que agora as parede já não estão mais se 
unindo.

Obs. Este procedimento pode ser feito para 
vários tipos de elementos como Vigas, Curtain
Wall, etc.
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Quando estamos desenvolvendo um projeto 
em Revit, muitas vezes temos que utilizar 
arquivos externos de referência. 

O importante aqui é entender como 
devemos prosseguir para minimizar os 
problemas de importação com o arquivo 
CAD.

Problemas como o aumento do tamanho do 
arquivo .RVT, elementos que aparecem no 
CAD mas não quando inseridos no Revit, 
entre outros.

Siga os passos ao lado e veja como prosseguir.

Quando emitimos os arquivos para os 
especialistas trabalharem, eles os utilizam como 
base para desenvolver seus projetos. Com isso, 
temos uma poluição de vários desenhos 
sobrepostos.

O primeiro passo é limpar o Arquivo no
AutoCAD. Abra o arquivo a ser importado e 
reveja todos os layers. Apague tudo aquilo que 
não será pertinente para o seu 
desenvolvimento.

Após apagar os elementos não pertinentes, 
execute o comando PURGE.

Após executar o comando PURGE, execute o 
comando “AUDIT”. Ele irá auditar o arquivo e 
corrigir todos os erros. 

Digite “Y” para corrigir os erros detectados.

Clique várias vezes 
em Purge All até 
eliminar todos os 
elementos de sua 
“memória”.

Após a limpeza manual, audit e purge, o 
arquivo estará pronto para ser inserido em seu 
projeto no Revit.
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Quando iniciamos em Revit, a vontade de 
construir acaba se sobressaindo à parte 
organizacional que é fundamental neste 
processo. 

Quero dizer, você criou uma vista, colocou-a 
na folha, e sempre que vai fazer alterações 
no projeto, utiliza esta vista toda poluída, 
que por vezes pode te prejudicar.

Trabalhar nestas vistas é muito arriscado, 
pois você pode apagar ou esconder 
elementos como cotas, tags e outras 
informações, que já estavam corretos para 
sua apresentação. 

O ideal é criar vistas de folhas e vistas de 
trabalho!

Siga os passos ao lado e veja como prosseguir.

Para criar as vistas de trabalho, basta selecionar 
a vista clicando com o botão direito do mouse e 
ir em Duplicate View> Duplicate.

Renomeie a vista duplicada com um prefixo de 
fácil reconhecimento, como por exemplo:
“Trabalho – 1º Pavimento” ou “Construção – 1º 
Pavimento”, etc.

Como comentamos, iremos utilizar as vistas 
de trabalho para construção no dia-a-dia e as 
vistas de folha para serem criadas as folhas 
com suas informações pertinentes.

Quando temos um projeto de grande porte, 
torna-se inviável gerenciar inúmeras vistas. 
Tanto a do projeto, quanto as de trabalho.

Por isso, temos a próxima dica (21 Organizar 
Vistas).  Não deixe de ver esta dica, pois ela é 
fundamental para controlar esse problema e 
poucos a utilizam!
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Essa dica é um pouco avançada. Tentamos 
simplificá-la ao máximo para você já 
começar a utilizar e praticar este tipo de 
organização que com certeza te ajudará 
muito em sua caminhada no Revit.

Quando desenvolvemos um projeto BIM no 
Revit, criamos centenas de vistas. Gerenciar 
estas vistas sem ter este conhecimento 
mínimo será muito complicado.

Fizemos um exemplo simples de como você 
pode organizar suas vistas. Neste caso, 
apenas separamos em vistas de Folhas e 
vistas de Trabalho.

Utilizando a mesma ideia base, de criação 
parâmetros e o Browser Organization, você 
pode deixar seu projeto excelentemente 
organizado. 

Siga os passos ao lado e veja como prosseguir.

Vamos criar um novo parâmetro para as vistas e 
vamos utilizá-lo para reorganizar o Project 
Browser.
Em Manage> Project Parameters, clique em Add

Preencha e selecione os campos abaixo:
Name: Tipo de Vista
Discipline: Common
Type of Parameter: Text
Group Parameter: Identity Data
Categories:       Views

Clique com o botão direito sobre Views (all) e 
clique em Browser Organization.

Clique New e crie um 
nome de sua escolha. 
Ex. DTM-Vistas 
Trabalho e Folha e 
clique em Ok.

Na aba Grouping and Sorting, selecione os 
itens conforme a figura abaixo:
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Perceba que ao finalizar o Browser Organization, 
vai aparecer “???”. Isso porque o parâmetro “Tipo 
de Vista” que estamos utilizando para separar as 
vistas não está preenchido.

Agora iremos selecionar as vistas de Folhas e 
iremos preencher o parâmetro “Tipo de Vista” 
com “Folha”.

Iremos fazer o mesmo para as vistas de 
Trabalho. Selecione as vistas que são para 
Trabalho e preencha o parâmetro “Tipo de 
Vista” com “Trabalho”.

Agora temos nosso Project Browser mais 
organizado, separando vistas de Trabalho e 
vistas de Folhas.
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Um grandíssimo problema que normalmente 
afeta 99% dos usuários é: Onde Baixar as 
Famílias? 

Eu diria que esse problema foi maior para 
aqueles que, assim como nós, começaram a 
trabalhar com Revit em 2005, quando o 
mercado não continha tantas opções. 

Neste momento não tivemos outra solução a 
não ser criarmos nossas próprias famílias.

Hoje encontramos um mercado já em 
processo de transformação e a indústria está 
acompanhando e gerando suas famílias.
A ideia aqui é mostrar alguns sites com as 
famílias essenciais para facilitar seu inicio no 
Revit.

Use as nossas indicações ao lado, pois elas irão 
te ajudar e muito!

Geralmente, temos que criar várias famílias 
específicas para nosso projeto. Mas, por outro 
lado, hoje já existem inúmeras famílias 
fornecidas pelos fabricantes que carregam 
informações específicas. Desta forma, 
recomendamos a utilização destes componentes.

O Revit City têm um grande acervo com vários 
tipos de famílias.
http://www.revitcity.com

É um site europeu com grande acervo de 
objetos BIM específicos de fabricantes de 
marcas líderes. Você poderá baixar e instalar o 
aplicativo acessando-o diretamente no Revit.

http://bimobject.com/pt-br/product

O site da própria Autodesk tem um grande 
acervo com mais de 68.000 famílias de vários 
tipos e fornecedores.
http://seek.autodesk.com/

Para que não faltem louças e metais para seu 
início de projeto, a DECA foi uma das pioneiras 
em disponibilizar esse tipo de família.
http://www.deca.com.br/biblioteca/arquivos-por-produtos

Cadastre, baixe e instale o aplicativo da Tigre. 
Com ele, você terá acesso a todo o acervo 
disponibilizado pela Tigre.
http://www.mundotigre.com.br/downloads.php

http://www.revitcity.com/
http://bimobject.com/pt-br/product
http://seek.autodesk.com/
http://www.deca.com.br/biblioteca/arquivos-por-produtos
http://www.mundotigre.com.br/downloads.php
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Planejamento é essencial para um projeto BIM

Nomenclatura

“Mover uma semente é muito fácil, difícil é deslocar uma árvore depois de adulta”.

Ao desenvolver um projeto em BIM, invista uma parte do tempo em
planejamento. Planeje como a equipe interna e a equipe externa
trabalharão e como os arquivos serão criados, compartilhados e
gerenciados. Defina em que nível de detalhe serão entregues as
etapas e para qual finalidade o modelo será criado. Antes de mais
nada, planeje a composição do próprio modelo: particionado,
composto, único, etc.

PLANEJAMENTO BIM

LEMBRE-SE SEMPRE DESTA ÁRVORE 
ANTES DE COMEÇAR!

Jonatas Olim | Deborah Costa 

Tipos de Arquivos

Modelo Central 

Modelo Local 

Infraestrutura

Viabilidade

Servidores

Internet

Revit Server

Etapas LOD

Workstation
Links

Backup

FamíliasParâmetros

Aprovação

Check-list
Metodologia

Manual de Coordenação

Processos
Administrator

Accelerator

Energético

Planejamento

Checagem de Interferências

Quantitativos

5D

FM

Documentação 

Comunicação

Equipes

Responsáveis

4D

Contratos

Técnico

Modelo

Análise



...então certamente está com mais dúvidas e isto é ótimo! Foi exatamente o que 
aconteceu com a gente. Entendemos que nesta jornada de aprendizado de coisas 
novas e revolucionárias as dúvidas são a certeza de que estamos caminhando. No 

meio desta viagem estaremos juntos com você!

Deborah Costa
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